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Structural Equation Modeling 

Overview 

Structural equation modeling (SEM) grows out of and serves purposes similar to 
multiple regression but in a more powerful way which takes into account multiple 
latent independent variables, each measured by multiple indicators; one or more 
latent dependent variables also each with multiple indicators; the modeling of 
mediators as both causes and effects; and modeling of interaction terms; 
modeling, nonlinearities; modeling correlated independent variables and 
correlated error; and modeling measurement error. SEM may be used as a more 
powerful alternative to multiple regression, path analysis, factor analysis, time 
series analysis, and analysis of covariance. In fact, these procedures may be seen 
as special cases of SEM.  

Models which may be implemented by SEM, depending on the capabilities of the 
statistical package,  include: 

• Linear and generalized multiple linear regression 
• Linear and generalized multivariate linear regression (multiple dependent 

variables) 
• ANOVA 
• Confirmatory factor analysis (CFA, which is SEM for measurement models) 
• Reliability analysis 
• Path analysis using measured variables 
• Structural equation modeling of measured and latent variables (SEM for 

structural models) 
• Multi-group modeling of measurement and structural models 
• Latent growth curve models 
• Multilevel models 

Advantages of SEM compared to multiple regression include more flexible 
assumptions; allowing interpretation even in the face of multicollinearity; use of 
confirmatory factor analysis to reduce measurement error;  testing models overall 
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rather than testing coefficients individually; testing models with multiple 
dependent variables; modeling complex causal paths taken by mediating 
variables; ability to go beyond the ordinary least squares (OLS) additive model 
which makes the dependent variable a function of the sum of effects; the ability 
to model error terms; the ability to test coefficients across multiple between-
subjects groups; and ability to handle difficult data such as time series with 
autocorrelated error, non-normal data, and incomplete data. Moreover, where 
regression is highly susceptible to error of interpretation due to misspecification, 
the SEM strategy of comparing alternative models to assess relative model fit 
makes it more robust. In addition to all this, there is the attraction of being able 
to create and test models using a graphical modeling interface. 

SEM is usually viewed as a confirmatory rather than exploratory procedure, using 
one of three approaches:  

1. Strictly confirmatory approach: A model is tested using SEM 
goodness-of-fit tests to determine if the pattern of variances and 
covariances in the data is consistent with a structural (path) model 
specified by the researcher. However as other unexamined models 
may fit the data as well or better, an accepted model is only a not-
disconfirmed model.  

 
2. Alternative models approach: The researcher may test two or more 

causal models to determine which has the best fit. There are many 
goodness-of-fit measures, each reflecting different considerations. 
Usually three or four fit measures are reported by the researcher. 
Although desirable in principle, this approach runs into the real-
world problem that in specific research areas, the researcher may 
not find in the literature two well-developed alternative models to 
test.  

 
3. Model development approach: In practice, a great many instances of  

SEM research combine confirmatory and exploratory purposes: a 
model is tested using SEM procedures, found to be deficient, and an 
alternative model is then tested based on changes suggested by  
modification indexes and other statistical output generated by SEM. 
The problem with the model development approach is that models 
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confirmed in this manner are post-hoc ones which may not be stable 
(may not fit new data, having been created based on the uniqueness 
of an initial dataset). Researchers may attempt to overcome this 
problem by using a cross-validation strategy under which the model 
is developed using a calibration data sample and then confirmed 
using an independent validation sample.  

Regardless of approach, SEM cannot itself draw causal arrows in models or 
resolve causal ambiguities. It is entirely possible that one model with arrows 
drawn in the opposite direction from a second model may fit the data equally 
well. Theoretical insight and judgment by the researcher is still of utmost 
importance.  

SEM is a family of statistical techniques which incorporates and integrates path 
analysis and factor analysis. In fact, use of SEM software for a model in which all 
variables are simple observed variables is a type of path analysis. Use of SEM 
software for a model in which each latent construct has multiple indicators but 
there are no direct effects (arrows) connecting the latent constructs is a type of 
factor analysis. Usually, however, SEM refers to a hybrid model with both multiple 
indicators for each variable (called latent variables or factors) and paths specified 
connecting the latent variables. Synonyms for SEM are covariance structure 
analysis, covariance structure modeling, and analysis of covariance structures. 
Although these synonyms rightly indicate that analysis of covariance is the focus 
of SEM, be aware that SEM can also analyze the mean structure of a model.  

See also partial least squares regression, which is an alternative method of 
modeling the relationship among latent variables, also generating path 
coefficients for a SEM-type model but without SEM's data distribution 
assumptions. PLS path modeling is sometimes called "soft modeling" because it 
makes soft or relaxed assumptions about data. See the separate Statistical 
Associates “Blue Book” volume on “Partial Least Squares.” 

Data examples in this volume 

The example datasets used in this volume are listed below in order of use, with 
versions for SPSS (.sav), SAS (.sas7bdat), and Stata (.dta). 
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The Wheaton dataset is a classic dataset described below. See Wheaton, Muthén,  
Alwin, & Summers (1977). 

• Right-click here download wheaton.sav for SPSS Amos. This 
illustrates correlation matrix input. 

• The Wheaton data for SAS is read in using a DATA step, discussed 
below. (There is no file). This illustrates covariance matrix input. 
Results are almost identical to correlation matrix input but 
covariance matrix input is preferred as it is possible for correlation 
matrix input to result in estimated standard errors being incorrect 
(cf. Cudeck, 1989).  

• Right-click here to download sem_sm2.dta (the version of the 
Wheaton data distributed by Stata). This illustrates correlation matrix 
input. 

 
The Wheaton dataset is also used in the section on confirmatory factor analysis 
(CFA) below. 
 
For the sections on structural modeling and specification search, a subset of the 
General Social Survey 2012 was used for which missing values were imputed using 
the SPSS multiple imputation module. Variables are described below.  

• Click here to download GSSsubset2012imputed.sav for SPSS Amos.   
• Click here to download GSSsubset2012imputed.sas7bdat for SAS.   
• Click here to download GSSsubset2012imputed.dta for Stata.   

 
The section on specification search, which is only available in SPSS Amos, uses the 
following file. Variables are described below. 

• Click here to download structur1.sav for SPSS Amos. 
 
The section on multi-group analysis uses a confirmatory factor analysis model on 
types of music. Variables are described below. 

• Click here to download music.sav for SPSS Amos.   
• Click here to download music.sas7bdat for SAS.   
• Click here to download music.dta for Stata.   

 
The section on latent growth curve analysis uses a dataset focused on a medical 
example involving growth of dental features in children. Variables are described  
below. 

http://www.statisticalassociates.com/data/wheaton.sav
http://www.statisticalassociates.com/data/sem_sm2.dta
http://www.statisticalassociates.com/data/GSSsubset2012imputed.sav
http://www.statisticalassociates.com/data/GSSsubset2012imputed.sas7bdat
http://www.statisticalassociates.com/data/GSSsubset2012imputed.dta
http://www.statisticalassociates.com/data/structur1.sav
http://www.statisticalassociates.com/data/music.sav
http://www.statisticalassociates.com/data/music.sas7bdat
http://www.statisticalassociates.com/data/music.dta
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• Click here to download royfm.sav for SPSS Amos.   
• Click here to download royfm.sas7bdat for SAS.   
• Click here to download royfm.dta for Stata.   

The section on Bayesian structural equation modeling used a subset of the 
General Social Survey 1993.  Variables are described below. 

• Click here to download GSS93subset.sav for SPSS Amos.   
 
The section on mixture modeling/latent class analysis used a version of the “Iris” 
sample file supplied with SPSS Amos.  Variables are described below. 

• Click here to download iris3.sav for SPSS Amos.   
 

The section on mean structure analysis used a version of the “GSS93subset” 
sample file supplied with SPSS Amos.  Variables are described below. 

• Click here to download GSS93 subset males imputed.sav for SPSS 
Amos.   

• Click here to download GSS93 subset females imputed.sav for SPSS 
Amos.   

• Click here to download GSS93subsetmergedimputed.sas7bdat for 
SAS.   

• Click here to download GSS93 subset merged imputed.dta for Stata.   
 
The section on generalized SEM uses a fictional dataset in which the latent 
variables Knowledge and Motivation are measured by 6 binary and 5 ordinal 
indicators respectively.  At this writing, Stata supports GSEM but not SPSS or SAS. 
Variables are described  below. 

• Click here to download gsemcfa.dta for Stata.   
 
 

Key Concepts and Terms 

The structural equation modeling process  

The researcher starts a SEM project by specifying a model on the basis of theory. 
Typically, each variable in the model is conceptualized as a latent construct  
measured by multiple indicators (e.g., stress as a latent variable measured by 
several survey items). Multiple indicators are developed for each latent variable, 

http://www.statisticalassociates.com/data/royfm.sav
http://www.statisticalassociates.com/data/royfm.sas7bdat
http://www.statisticalassociates.com/data/royfm.dta
http://www.statisticalassociates.com/data/GSS93subset.sav
http://www.statisticalassociates.com/data/iris3.sav
http://www.statisticalassociates.com/data/GSS93%20subset%20males%20imputed.sav
http://www.statisticalassociates.com/data/GSS93%20subset%20females%20imputed.sav
http://www.statisticalassociates.com/data/GSS93subsetmergedimputed.sas7bdat
http://www.statisticalassociates.com/data/GSS93%20subset%20merged%20imputed.dta
http://www.statisticalassociates.com/data/gsemcfa.dta
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with at least two and preferably three or more indicators per latent variable.   
Simple one-measure variables such as gender may also be in the model. 

Based on a large representative sample, a type of factor analysis analogous to 
common factor analysis (principal axis factoring), not principle components 
analysis, is used to establish that indicators seem to measure the corresponding 
latent variables. The researcher proceeds only after the measurement model has 
been validated. Two or more alternative models (one of which may be the null 
model) are then compared in terms of model fit, measures for which assess the 
extent to which the covariances predicted by the model correspond to the 
observed covariances in the data.  

Indicator variables  

Indicator variables are observed variables, sometimes called manifest variables or 
reference variables. Items in a survey instrument may be indicator variables, for 
instance. Four or more indicators are recommended, though three is acceptable 
and common practice. As few as two indicators or even a single indicator may be 
acceptable if the researcher is confident in the measure's validity and reliability.  

The prime consideration in selecting indicators is whether they are theoretically 
sound and reliably measured. Also, allowing one- and two-indicator latent 
variables to a model may allow the testing of theoretically important latent-level 
control relationships which otherwise might not be possible. However, with one 
indicator, error cannot be modeled but rather one must specify a fixed 
measurement error variance. Also, models using only two indicators per latent 
variable are more likely to be under-identified and/or fail to converge and error 
estimates may be unreliable. Ideally, indicators should have pattern coefficients 
(factor score weights) of .7 or higher on their latent factors, though this is a 
stringent test. A less stringent criterion is the that standardize path weights from 
the latent variables to their indicator variables should be .7 or higher.  

Indicator variables cannot be combined arbitrarily to form latent variables. For 
instance, combining gender, race, or other demographic variables to form a latent 
variable called "background factors" would be improper because it would not 
represent any single underlying continuum of meaning. The confirmatory factor 
analysis step in SEM is a test of the meaningfulness of latent variables and their 
indicators but the researcher may wish to apply reliability tests (ex., Cronbach's 
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alpha or ordinal item alpha) or conduct traditional factor analysis (ex., principal 
axis factoring) as well.  

Latent variables  

Latent variables are the unobserved variables/constructs/factors which are 
measured by their respective indicators. Latent variables include both 
independent, mediating, and dependent variables.  Those with no prior causes 
are called exogenous variables while mediating and dependent variables are 
called endogenous  variables. 

Exogenous variables 

Exogenous variables are independent variables with no prior causal variable 
(though they may be correlated with other exogenous variables, depicted by a 
double-headed arrow). In fact it is usual to assume that all exogenous variables 
are correlated (connected by a double-headed covariance arrow) unless there is 
theoretical reason not to. If two exogenous variables are connected by a 
covariance arrow, there cannot also be a straight (regression path) arrow nor can 
the researcher place a covariance arrow connecting an exogenous variable to an 
endogenous variable. Exogenous latent variables are sometimes denoted by the 
Greek letter ksi (ξ).  

Endogenous variables  

Endogenous variables are dependent or mediating variables (variables which are 
both effects of other exogenous or mediating variables, and are causes of other 
mediating and dependent variables). Dependent variables have incoming causal 
effects but no outgoing causal effects (other than to their own indicator 
variables). Thus endogenous variables are on the receiving end of single-headed 
straight arrows indicating a regression path and implying a causal relationship. 
The path to the endogenous variable may come from an exogenous variable or 
another endogenous variable. Endogenous constructs are sometimes denoted by 
the Greek letter eta (η). Variables in a model may be "upstream" or 
"downstream" depending on whether they are being considered as causes or 
effects respectively.  
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While SEM packages are used primarily to implement models with latent variables 
(see below), it is possible to run regression models or path models using only 
simple indicator variables.  

Regression models, path models, and SEM models 

In one sense, all regression models are path models and are a subset of SEM 
models. However, for those who wish to distinguish rather than conflate these 
three terms, the following differences are implied. 

• Regression models: In regression models, only observed variables are 
modeled and only the dependent variable in regression has an error term. 
Independent variables are assumed to be modeled without error. The only 
possible model is graphically a "star," with the arrows from all independent 
variables ending at the dependent variable. The partial coefficient for any 
independent variable controls for all other independents, whether or not 
an actual causal control effect is plausible.  

• Path models: Path models also contain only observed variables (there are 
no latent variables). Unlike regression models but like structural equation 
models, independent variables can be both causes and effects of other 
variables. That is, path models are like SEM models in having circle-and-
arrow causal diagrams, not just the "star" design of regression models. Only 
the endogenous variables in path models have error terms. Unlike SEM 
models, exogenous variables in path models are assumed to be measured 
without error. Partial coefficients are calculated using only the independent 
variables in a direct path to the endogenous variable. Using SEM packages 
for path models instead of doing path analysis using traditional regression 
procedures has the benefit that measures of model fit, modification 
indexes, and other aspects of SEM output discussed later become available.  

• SEM models: SEM models contain one or more latent variables. Typically, 
all variables in the structural model are latent variables though it is 
permissible to include simple/observed variables such as “Gender”. SEM 
models also support complex paths connecting variables in the model and 
support multiple dependent variables. Unlike path models with only 
observed variables, SEM models allow error associated with variables in the 
model to be themselves modeled (ex., models may be compared with and 
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without an assumption of error covariance between variables, or with 
equality or other constraints for pairs of error terms).  

Model specification  

Model specification is the process by which the researcher lists variables in the 
model and lists which effects among latent variables are null, which are fixed to a 
constant (usually 1.0), and which vary. That is, three types of relationships may 
connect specified variables: 

• In a SEM model, most straight (path) arrows indicate a regression 
relationship which is unconstrained and must be estimated. Likewise, 
double-headed covariance arrows indicate a correlation which is 
unconstrained and must be estimated. 

• The absence of  path and covariance arrows connecting two variables 
stipulates that the path or covariance weight is 0, representing no direct 
relationship (independence). 

• It is also possible for the researcher to constrain a path or covariance to a 
particular value. For instance, it is almost always the case that the path 
from a latent variable to one of its indicator variables is constrained to 1, in 
order to set the metric for the latent variable (see below). In fact, this is 
typically done by software automatically. 

Model parsimony 

A model in which no effect is constrained to 0 (every variable has a direct arrow 
connecting it to every other variable) is a “saturated” model which will always fit 
the data perfectly, even when the model makes no sense. The closer the 
researcher's default model is to this most-complex model, the better will be the 
fit. That is, adding paths will tend to increase fit. This is why a number of 
goodness of fit measures discussed later below penalize for lack of parsimony.  

A corollary is that if the researcher’s model is the saturated model, it cannot 
usefully be tested by SEM. The researcher’s model of interest must be more 
parsimonious than the saturated model. 

Note lack of parsimony may be a particular problem for models with few 
variables. If there are only three variables, for instance, it may be tempting to 
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have arrows connecting each variable with each other variable, but the 
researcher’s default model must be more parsimonious than the saturated model 
(the model with all possible direct arrows). Ways to increase parsimony are 
erasing direct effects (straight arrows) connecting one latent variable to another 
or erasing covariance arrows.  In each case, arrows should be erased from the 
model only if there is no theoretical reason to suspect that the effect or 
correlation exists. Customarily, the researcher seeks the most parsimonious well-
fitting model.  

Is the most parsimonious model the one with the fewest terms and fewest 
arrows? Yes, but a broader view should be taken.  Much more weight should be 
given to parsimony with regard to structural arrows connecting the latent 
variables (and simple variables, if any) than to measurement arrows from the 
latent variables to their respective indicators. Indeed, having more than the 
minimum number of indicator variables per latent variable is desirable. Also, if 
there are fewer exogenous and mediating variables in the model and yet the 
dependent variable or variables is/are equally well explained, that is parsimony 
also since fewer predictor variables will almost always mean fewer arrows.  

Model development 

The measurement model versus the structural model 

SEM analysis typically proceeds in two steps: validation of the measurement 
model, then testing the structural model.  Both steps are discussed much more 
fully in a later section.  

The measurement model consists of the latent variables and their indicator 
variables. Connections among the latent variables are not considered. The 
measurement model step is called “confirmatory factor analysis” (CFA) because 
its purpose is to validate (confirm) the way the researcher has measured the 
latent variables (factors) in the model. If SEM analysis shows good fit, this is an 
indication that indicator variables reflect the latent variables they are supposed to 
and that the latent variables are different from each other.  That is, CFA 
establishes convergent and divergent validity in the proposed model. 

If CFA upholds the measurement model, then the researcher proceeds to test the 
structural model. The structural model is the measurement model plus the latent 
variables and the paths and covariances connecting them. The same goodness-of-
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fit coefficients available in CFA are available for the structural step as well. The 
researcher is seeking to establish that the structural model has good fit to the 
data or, better yet, that one model fits the data better than another model. 

Model trimming versus model building 

After the structural model is run, it is necessary to evaluate it and consider 
modifying it.  In fact, a common type of SEM article tests a model taken from the 
literature, finds it deficient in some way, then proposes a modified model which 
fits the data better than the original model. In modifying an existing model, it is 
possible to add paths and/or covariance (model building or model growing), or 
the researcher may remove paths and/or covariances (model trimming).  

Although both strategies may be pursued in any order, a common convention is 
to grow the model using modification indexes and then to trim the model using 
significance tests of the path (regression) coefficients. Of course, additions to and 
deletions from the model should make theoretical sense. For instance, adding an 
arrow from a variable associated with a later time to a different variable 
associated with an earlier time is a chronological impossibility, no matter what a 
modification index suggests. Modification indexes are discussed below. 

The usual procedure is to overfit the model, then change only one parameter at a 
time. That is, the researcher first adds paths one at a time based on theory and on 
the modification indexes (MI’s), then drops paths one at a time based on the 
likelihood ratio (chi-square difference) test or Wald tests of the significance of the 
structural coefficients, discussed below. Modifying one step at a time is important 
because the MI’s are estimates and will change each step, as may the structural 
coefficients and their significance.  

As paths are added to the model, chi-square tends to decrease, indicating a better 
fit and also increasing the chi-square difference. That is, a significant chi-square 
difference indicates the fit of the more complex model is significantly better than 
for the simpler one. Adding paths should be done only if consistent with theory 
and face validity.  

When the model growing process has gone as far as judicious, then the 
researcher may erase one arrow at a time based on non-significant structural 
paths, again taking theory into account in the trimming process. Some authors, 
such as Ullman (2001), recommend that the alpha significance cutoff deleting 
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model effects (arrows) be set at a more stringent .01 level rather than the 
customary .05, on the rationale that after having added parameters on the basis 
of theory, the alpha significance for their deletion should involve a low Type I 
error rate. More than one cycle of building and trimming may be needed before 
the researcher settles on the final model. 

Modification indexes and parameter change 

Modification indexes (MI) are used in conjunction with parameter change 
coefficients to judge whether the model would be improved significantly by 
adding arrows. Note that in Amos, the MI table is not computed if the dataset 
contains missing values. There is more than one table of MI coefficients:  

• MI’s for regression weights (paths(): In the case of MI for estimated 
regression weights, the MI has to do with the change in chi-square if the 
path between the two variables is added to the model, with larger MI 
suggesting stronger reason to add the path.  

• MI’s for covariances: In the case of modification indexes for covariances, 
the MI has to do with the decrease in chi-square if two error term variables 
are allowed to correlate. For instance, if the MI for a covariance is 24 and 
the "Par Change" is .8, this means that if the model is respecified to allow 
the two error terms to covary their covariance would be expected to 
change by .8, leading to a reduction of model chi-square by 24 (lower is 
better fit). Even if MI and Par Change indicate that model fit will increase if 
a covariance arrow is added between indicator error terms, the standard 
recommendation is not to do so unless there are strong theoretical reasons 
in the model for expecting such covariance (ex., the researcher has used a 
measure at two time periods, where correlation of error would be 
predicted). That is, error covariance arrows should not be added simply to 
improve model fit.  

• MI’s for error terms: MI’s may suggest adding covariance arrows 
connecting error terms. Generally, the researcher does not want to add a 
covariance arrow between the error term for an indicator variable for one 
latent variable and the error term for an indicator variable for a different 
error term. Rather, the researcher generally wishes the indicator variables 
for different latent variables to be uncorrelated, and for their error terms to 
be uncorrelated as well, so as to preserve the conceptual distinction 
between latent variables.  If the suggested covariance is between error 



STRUCTURAL EQUATION MODELING               2015 Edition 
 

Copyright @c 2015 by G. David Garson and Statistical Associates Publishing Page 27 
 

terms of two indicator variables for the same latent variable, this means 
that once the latent cause of correlation of the two indicator variables is 
accounted for (by the latent variable), there is still an unmeasured 
influence connecting the two indicator variables.  This influence might be 
that one indicator causes the other, or they may share an unmeasured 
common influence connecting them. Further investigation is warranted. An 
alternative strategy might be to drop one of the indicator variables, but this 
runs the risk of reducing the reliability of the latent variable as a measure.  

MI coefficients may be used to alter models to achieve better fit but this must be 
with theoretical justification. Some oppose use of MI’s altogether on the ground 
that all model specifications should be theory-driven, not data driven. Blind use of 
MI runs the risk of capitalization on data noise and model adjustments which 
make no substantive sense. Simulation studies by Silvia and MacCallum (1988; see 
also MacCallum, 1986) found most MI-suggested model changes to misspecified 
models were incorrect and did not reproduce the model known to be true and 
which generated the data. Moreover, when n is large, even very small 
discrepancies between the model-implied and the observed covariance matrix 
may trigger an MI flag.  The researcher should be aware that MI’s are just flags to 
consider adding a direct path or covariance and may represent mistaken 
suggestions.  

If  MI’s are used, the researcher should also take into account the effect size of 
the arrow to be added as indicated by the parameter change coefficient. “Par 
change" is the estimated path coefficient change when adding arrows. Since 
absence of an arrow corresponds to a 0 path coefficient weight, “Par change” is 
the regression coefficient for the added arrow. "Par change," also called 
"expected parameter change" (EPC) in Stata and some other software, is an effect 
size measure. Most SEM software will list the expected parameter change and its 
significance level along with the MI for that path. If the given arrow is added, the 
actual new parameter value may differ somewhat from the "Par Change" 
estimate.  The researcher may decide not to add an arrow flagged by MI if the 
parameter change is trivial. Likewise, the researcher may wish to add an arrow 
where the parameter change is large in absolute size even if the corresponding MI 
is not the largest one. 

How large is a “large” MI? The minimum value would be 3.84, since chi-square 
must drop that amount simply by virtue of having one less parameter (path) in 
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the model. This is why the default threshold is set to 4 in Amos and most SEM 
software. The researcher can set a higher value if wanted, causing MI’s below the 
specified level not to be output.  

To summarize, the researcher may consider adding an arrow to the model if the 
MI is high and the parameter change coefficient is high and it makes theoretical 
sense.  A variety of criteria have been used: 

• Consider adding a path if the modification index exceeds 100. 
• Consider adding a path for the largest MI which also is associated with a 

large enough parameter change to affect substantive interpretations of 
effects in the researcher’s particular context. 

• On an exploratory basis, the researcher may assess adding which arrows, if 
any, causes fit indexes to reach acceptable levels.  

Although a number of criteria have also been suggested as rules-of-thumb for a 
“large” MI (> 4, >10, >30, and >100 have been mentioned), such criteria are 
beside the point, which is to consider adding arrows to the model if justified by 
theory and if adding the arrow will cause model fit to reach acceptable levels. 
The MI is simply a flag which suggests to the researcher which arrows to 
consider.  The less certain the theoretical justification for adding an MI-flagged 
path or covariance, the greater the need for cross-validation of the model on 
other data than the model-development data.  

The Lagrange multiplier coefficient 

SAS and Stata output the Lagrange multiplier (LM) statistic rather than the MI 
statistic, though both serve the same function. The LM statistic is sometimes 
called "multivariate MI," and serves the same function in SAS and Stata output. In 
fact, Stata labels the LM statistic as “MI”, though SAS labels it “LM”. While 
univariate MI in Amos and multivariate MI (LM) in SAS and Stata frequently lead 
to the same conclusions, this is not always the case as an example later on below 
demonstrates. 

LM would is especially appropriate if the researcher is considering adding an 
entire set of arrows to the model since different conclusions might arise from the 
multivariate LM approach as compared with a series of individual MI decisions. 
On the other hand, larger LM or MI both flag possible arrows to add to a model 



STRUCTURAL EQUATION MODELING               2015 Edition 
 

Copyright @c 2015 by G. David Garson and Statistical Associates Publishing Page 29 
 

and the usual procedure is to add arrows one at a time, rerunning the model after 
each addition.  

Path significance and critical ratios 

Model trimming usually centers on deleting arrows in the model which are not 
significant, provided it makes theoretical sense to do so. For regression paths, 
most SEM software will print out the p significance level and in social science, p 
values above .05 flag non-significant paths. 

If the p value is not available, paths with a critical ratio greater than 1.96 indicate 
that path is significant at the .05 level or better. Significance of covariances is 
interpreted in the same manner. Greater than 2.58 indicates significance at the 
.01 level or better.  Amos and some other packages indicate the .05 level with one 
asterisk, the .01 level with two asterisks, and the ,001 level with three asterisks. 
The significance of the standardized and unstandardized estimates will be 
identical so some statistical packages, including Amos, do not print the significant 
level for standardized coefficients.  

Model fit 

A quite large number of different types of goodness-of-fit coefficients are 
available to assess both confirmatory factor analysis and structural models. The 
correspondence of these fit measures to true causality is a subject of great 
controversy, with positions ranging from rejection of any use of fit measures to 
embrace of their use. Understanding this controversy is important to proper use 
of fit measures. As a practical matter, however, the great majority of SEM studies 
finding their way to publication report goodness of fit measures.  Meeting 
goodness of fit criteria does not assure that the causal model is true, but failing to 
meet fit criteria is reason to strongly suspect the model is false. This topic is 
explored at greater length in a later section. 

Non-hierarchical model comparisons 

Model-building and model-trimming, discussed above, involve comparing a model 
which is a nested subset of another. If modeling does not simply involve adding 
and subtracting path and covariance arrows in the model,  then one model may 
not be nested within another. The likelihood ratio test of model chi-square 
difference cannot be used directly for non-hierarchical models, only nested 
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models. This is because model fit by chi-square is partly a function of model 
complexity, with more complex models fitting better. For non-hierarchical model 
comparisons, the researcher should use information theory goodness of fit 
measures which penalize for complexity (reward parsimony), such as AIC or BIC, 
since these handle comparison of non-nested models (however, see discussion 
below).   

Software packages 

This volume covers structural equation modeling in SPSS, SAS, and Stata. While all 
three packages can implement most SEM models, at this writing Stata is the most 
comprehensive package insofar as it supports generalized SEM (support for non-
normal distributions and a variety of link functions) and hierarchical SEM (support 
for multilevel/linear mixed SEM modeling). 

• SPSS. Amos (Analysis of MOment Structures) is the SPSS SEM module. It 
features a user-friendly graphical interface and has become popular as a 
relatively easy way to specify models. However, also available in Amos is a 
BASIC programming mode. At this writing, Amos does not support 
generalized SEM or hierarchical SEM. 

• SAS. SEM is implemented in SAS using PROC CALIS.  SAS briefly supported 
PROC TCALIS on an experimental basis, handling multi-group SEM and 
analysis of mean structures, but its features have now been folded back 
into PROC CALIS.  At this writing, SAS does not support generalized SEM or 
hierarchical SEM.  

• Stata:  The Stata sem command implements structural equation models for 
normally distributed data. The gsem command implements generalized 
SEM, which supports non-normal distributions and a variety of link 
functions.  In addition, starting with Version 13, Stata supports hierarchical 
structural equation modeling, including hierarchical generalized SEM.  An 
extension for generalized linear latent and mixed models (GLLAMM) 
supports multilevel models, generalized models, latent class models, item 
response models, factor models, and structural models. GLLAMM programs 
for Stata are documented at http://www.gllamm.org/ and in Rabe-Hesketh, 
Skrondal, & Pickles (2004, 2005).  Type  net install gllamm to install this 
user-written add-on and then type help gllamm from the Stata command 
prompt. 

http://www.gllamm.org/
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Other statistical packages.  

• Mplus software (developed by Muthén, 2002a, 2002b) supports more 
complex models involving a mix of nominal ordinal, and continuous 
variables, including multilevel (hierarchical) data and random effects. MPlus 
also handles generalized SEM and discrete-time survival models.  

• xxM is an R-language package which supports multilevel structural equation 
modeling, cross-classified models, longitudinal models, and linear growth 
models. At this writing it was free. 

• Lisrel popularized SEM in sociology and the social sciences and is still the 
package of reference in many articles employing structural equation 
modeling.  

• EQS is another long-standing and widely used SEM package.    

User interfaces for SEM 

In most statistical packages, structural equation models may be entered 
graphically, as illustrated below using the Wheaton data.  This classic dataset is 
used by Amos, SAS, Stata, MPlus, and numerous other packages and textbooks to 
illustrate a simple SEM model. In this model, focusing on the stability of 
“Alienation” as a construct between 1967 and 1971, the following variables are 
used:  

• anomia67 and powles67: observed indicators of “Alienation67” 
• anomia71 and powles71:  observed indicators of “Alienation71” 
• educatio and sei: observed indicators of “SES”, which is socioeconomic 

status.  

The model posits that Alienation71 is caused by Alienation67, and both are 
caused by SES. Also posited in this version of the model are covariances between 
anomia67 and anomia71; and between powles67 and powles71.  

The SPSS Amos interface 

Most Amos users employ the Amos graphical user interface shown below. Using 
menu choices and tools shown on the left of the figure below (tools also may be 
invoked  using the Diagram menu choice), the structural equation model is drawn.   
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• Selecting View > Variables in the Data causes a variable list to pop up. 
Variables may be dragged to the rectangles, which are the measured 
variables.  

• Using View > Object Properties, names may be given to the ovals, which are 
the latent variables.  

• Using Plugins > Name Unobserved Variables, the error terms shown as 
small circles may be labeled.  

• The single black arrow tool in the upper left, second row of icons, is used to 
draw hypothesized causal arrows.  

• The double-headed arrow tool next to it is used to draw covariance 
relationships. 
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In Amos, the general process of structural modeling is to use the icons above 
to draw a circle-and-arrow path diagram, associated the diagram with data (a 
correlation matrix or raw data). When the model is fully drawn and analysis 
and output options  are selected, the Analyze > Calculate Estimates menu 
selection runs the model. View > Text Output enables the researcher to view 
and print results. 
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In tandem with using the Amos graphical interface to draw a model, the File > 
Data Files menu choice is used to specify the data. Below is the data file for the 
Wheaton example. As can be seen Amos accepts covariance or  correlation matrix 
input, not just raw data.  

END OF PREVIEW OF FIRST 33 PAGES 

To buy the Kindle version for $9.99, click here.  
 

http://www.amazon.com/dp/B009442Y1G
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To buy the entire Statistical Associates library of 50 statistics books in no-
password pdf format on DVD plus one year of free updates for $120,  click here. 
 
To register for a password-protected pdf version when available, go to 
http://www.statisticalassociates.com . 
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